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Abstract: 

Fingerprint image identification plays a critical role in crime detection and forensic investigations. By analyzing the 

unique patterns present on the friction ridge skin of an individual's fingertips, fingerprints serve as a reliable biometric 

identifier. This paper provides an overview of the process involved in fingerprint image identification for crime 

detection. The collection of fingerprint images can be done using various methods, including ink and paper, live 

scanning devices, or optical scanners. In crime scene investigations, latent fingerprints are often lifted from surfaces 

using techniques such as dusting or chemical development. Once collected, fingerprint images may undergo 

enhancement techniques to improve clarity and contrast. The next step involves feature extraction, where distinctive 

characteristics, such as ridge endings and bifurcations, are identified and recorded. These features are used to generate a 

fingerprint template, a standardized digital representation of the fingerprint. Comparison is then performed between the 

captured fingerprint image or latent print and a database of stored fingerprints.  
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I. INTRODUCTION: 

 

Fingerprint image identification is a vital component of crime detection and forensic 

investigations. Fingerprint patterns, unique to each individual, have long been recognized as a 

reliable biometric identifier. The analysis and comparison of fingerprint images play a crucial 

role in linking individuals to crime scenes, identifying suspects, and providing evidence for the 

prosecution of offenders. The uniqueness and permanence of fingerprints make them valuable in 

forensic science. The ridges and valleys on the friction ridge skin of fingertips create distinct 

patterns that remain largely unchanged throughout a person's lifetime. This characteristic has 

made fingerprints an integral part of law enforcement agencies worldwide. Fingerprint image 

identification involves several key steps, including collection, enhancement, feature extraction, 

comparison, and expert analysis. Fingerprint images can be obtained through various techniques 

such as ink and paper, live scanning devices, or optical scanners. Latent prints, invisible to the 

naked eye, are often lifted from surfaces at crime scenes using specialized techniques. 

Enhancement techniques are employed to improve the clarity and contrast of fingerprint images, 

ensuring better visibility of the ridge details. Feature extraction involves identifying and 

recording distinctive characteristics, such as ridge endings and bifurcations, which are used to 

create a standardized digital representation known as a fingerprint template. The comparison 

process matches the captured fingerprint image or latent print against a database of known 

fingerprints. Automated algorithms calculate the similarity or dissimilarity between the features, 

providing a similarity score or rank ordering of potential matches. Expert forensic analysts 

review and validate the results, considering additional contextual information and evidence. 

 

Accurate and reliable fingerprint image identification is crucial for the successful resolution of 

criminal cases. It aids in individual identification, corroborates evidence, identifies potential 

suspects, searches criminal history databases, and supports the prosecution of offenders. 

Furthermore, maintaining comprehensive fingerprint databases helps in prevention and 

deterrence by linking individuals to previous offenses. The advancement of technology has 

brought about significant improvements in fingerprint image identification, including automated 
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algorithms, sophisticated enhancement techniques, and efficient database management systems. 

These advancements continue to enhance the accuracy, efficiency, and reliability of fingerprint 

identification, contributing to the field of forensic science and ensuring justice is served. In this 

context, this paper explores the techniques, challenges, and advancements in fingerprint image 

identification for crime detection, highlighting the importance of this field in modern forensic 

investigations. Fingerprint image identification has been a fundamental tool in the field of 

forensic science for many decades. The unique patterns present on an individual's fingertips have 

long been recognized as a reliable means of identification. Fingerprint analysis plays a critical 

role in crime detection, helping investigators link individuals to specific criminal activities and 

providing valuable evidence for the legal process. The human fingerprint is characterized by 

intricate ridge patterns, including loops, whorls, and arches. These patterns are formed during 

fetal development and remain unchanged throughout a person's lifetime, making fingerprints a 

highly accurate and stable biometric identifier. This uniqueness and permanence have led to the 

widespread adoption of fingerprint identification as a primary method for individual recognition. 

The process of fingerprint image identification involves several stages, starting with the 

collection of fingerprint samples. This can be done through traditional methods using ink and 

paper, or through modern live scanning devices and optical scanners. 

2.LITERATURE REVIEW: 
In criminal investigations, latent fingerprints left behind at crime scenes are often recovered 

and processed using specialized techniques such as dusting or chemical development. Once 

collected, fingerprint images may undergo enhancement procedures to improve their quality 

and increase the visibility of ridge details. Enhancement techniques can include contrast 

adjustment, noise reduction, and ridge orientation estimation, all aimed at producing clear 

and legible fingerprint images for analysis. The next step is feature extraction, where unique 

characteristics of the fingerprint, known as minutiae, are identified and recorded. These 

minutiae include ridge endings, bifurcations, and other ridge characteristics that form the 

basis of fingerprint comparison and matching. Comparison is performed by matching the 

extracted minutiae from the captured fingerprint image or latent print against a database of 

known fingerprints. Automated algorithms employ various matching algorithms and 

similarity scoring methods to determine the degree of similarity between the fingerprints and 

rank potential matches. While automated algorithms play a significant role in fingerprint 

identification, human expertise is indispensable. Forensic experts with specialized training 

and experience analyze the results, validate the matches, and provide expert opinions and 

testimony in legal proceedings. The combination of automated algorithms and expert analysis 

ensures accurate and reliable identification outcomes. Fingerprint image identification has 

revolutionized the field of forensic science, enabling law enforcement agencies to solve 

countless crimes and bring offenders to justice. The advent of computerized fingerprint 

databases has facilitated rapid and efficient searches, significantly enhancing the speed and 

effectiveness of investigations. However, challenges remain in the field of fingerprint image 

identification. The analysis of latent prints can be particularly complex due to the often 

partial, distorted, or degraded nature of the prints. Developing robust techniques for latent 

print enhancement and matching is an ongoing area of research. Privacy and data security are 

also critical concerns in fingerprint identification systems. Safeguarding the integrity of 

fingerprint databases, ensuring secure access, and protecting individuals' privacy rights are 

essential considerations that must be addressed. In conclusion, fingerprint image 

identification is a powerful tool in crime detection and forensic investigations. Its unique and 

stable nature, coupled with advancements in technology and automated algorithms, have 

greatly enhanced the accuracy and efficiency of fingerprint identification systems. With 

continued research and development, fingerprint image identification will remain a 

cornerstone of forensic science, aiding in the pursuit of justice and the maintenance of law 

and order. 

3.BLOCK DIAGRAM: 
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Fig1. block diagram for fingerprints images. 

Existing systems:Fingerprints in the crime scene plays an important role to identify the criminal 

involved in the crime. Crime scene images (CSI) are images taken from the crime spot. When 

crime is occurred, the investigator takes both latent and patent sample of fingerprints left behind. 

The patent fingerprints are visible by naked eye, so they are simply photographed. But latent 

fingerprints are invisible and these samples are more difficult to perceptible. These samples can 

be lifted through different techniques. The use of cyanoacrylate vapours which sticks to prints 

and make them visible in the present of normal light. This method is much difficult, so normally 

incrime scene, the investigators apply a fine dusting 

powder (aluminium dust or black granular) to the 

surface in which fingerprints to be extracted. The 

dust actually sticks to the fingerprint then they use 

clear tape to lift the fingerprint. After the lifting the 

fingerprints, the prints are scanned and saved in the 

digital image form. The fingerprints taken from the 

crime scene is unintentionally made and these 

images are noisy or partial prints and difficult to 

identify. 

 
Fig2. Minutiae matching 
 

Proposed System: The CNN uses successive convolutional layers with a non-linear ReLu 

function for storing the features of an image having a specific dimension.  

 

Maxpooling layers are used for down sampling. The fully connected layer multiplies the input by 

a matrix with sigmoid activation function and adds to a bias vector which contains the feature 

map. The images obtained from the crime scene are called crime scene images (CSI). These 

images play important role and used as evidence in criminal cases. The fingerprint information 

contained in the images collected directly from the crime scene may be partial or tough to 

identify. This can lead to fingerprint images of bad or low quality. Due to the low quality of 

fingerprint image to another systematic image feature, the early fingerprint image quality may be 

of exterior value of identification. To moderate this problem, the fingerprint allows to perform 

image pre-processing, to feature mark up and identification  
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analysis. Segmentation is a first step in image enhancement which converting low-level image 

processing transforming a gray scale image into high-level image description in terms of features, 

objects and scenes. It partitions an image into distinct region containing each pixel with similar 

characteristics. Fingerprint skeletonization is used to reduce ridges until one pixel wide. The 

fingerprint features like minutiae are extracted from the skeleton images. The ROI is extracted 

using open and close operation by discarding the image areas without effective ridges and 

terminates. The remaining effective area is divided into two areas, to determine bound the white 

area used and to represents the inner area the gray area used.  

  3.1 COMPONENTS: 

 

 Arduino:The Arduino is a family of microcontroller boards to simplify electronic design, 

prototyping and experimenting for artists, hackers, hobbyists, but also many professionals. 

People use it as brains for their robots, to build new digital music instruments, or to build a 

system that lets your house plants tweet you when they‘re dry. Arduinos (we use the standard 

Arduino Uno) are built around an ATmega microcontroller — essentially a complete computer 

with CPU, RAM, Flash memory, and input/output. 

 

 

 

 

 

 

 

 

 

 

 Arduino Software:Launch the Arduino application 

 If you disconnected your board, plug it back in 

 Open the Blink example sketch by going to: File > Examples > 1.Basics > Blink 

 

 Select the type of Arduino board you‘re using: Tools > Board > your board type 

 

 Select the serial/COM port that your Arduino is attached to: Tools > Port > COMxx 
 

 If you‘re not sure which serial device is your Arduino, take a look at the available ports, then 

unplug your Arduino and look 

 

 

 

  again. The one that disappeared is your Arduino. 

 With your Arduino board connected, and the Blink sketch open, press the ‗Upload‘ button 

 After a second, you should see some LEDs flashing on your Arduino, followed by the message 

‗Done Uploading‘ in the status bar of the Blink sketch. 

 If everything worked, the onboard LED on your Arduino should now be blinking! You just 

programmed your first Arduino! 

 Relay:Relay modules are simply circuit boards that house one or more relays. They come in a 

variety of shapes and sizes, but are most commonly rectangular with 2, 4, or 8 relays mounted on 

them, sometimes even up to a16relays. 
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Arduino relay module 

Hobbyists often use a relay module with Arduino in their projects. An Arduino is a micro 

contoller board that is widely popular in DIY electronics projects. The relay module, when paired 

with an Arduino, can control various apply. 

 

 Motor: A DC motor (Direct Current motor) is the most common type of motor. DC motors 

normally have just two leads, one positive and one negative. If you connect these two leads 

directly to a battery, the motor will rotate. If you switch the leads, the motor will rotate in the 

opposite direction. 

 

 
Dc motor  

 ESP32:  

 
It is a figure that what is there in ESP32 

Also connection with the Arduino as shown in below figure, 
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 Fingerprint: fingerprint sensor modules,like the one in the following figure, made fingerprint 

recognition moreaccessible and easy to add to your projects. This means that is  super easy to 

make fingerprint collection, registration, comparison and search. 

 

 
 

These modules come with FLASH memory to store the fingerprints and work with any 

microcontroller or system with TTL serial. These modules can be added to security systems, door 

locks, time attendance systems, and much more. 

 

 
 This sensor has six pins to connect to  

 Bred board and Arduino. 

 The fingerprint sensor module used in this project came with really thin wires, so soldering 

breadboard-friendly wires was needed. We recommend using different colors according to the pin 

function. In our case: 

 DNC – white wires 

 VCC – red wire 

 TX – blue wire 

 RX – green wire 

 GND – black wire 

 

4.DESIGN FLOW: 

 

https://makeradvisor.com/tools/fingerprint-sensor-module/
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 Turn on the power supply. 

 There are two categories enrollment and identification. 

 The first thing we had to do is fingerprint acquisition, to collect all the fingerprint data. 

 Next thing is to do preprocessing. 

 In the next step is feature extraction. 

 Then we have to classify the fingerprints like details etc. 

 After above step go for the matching of the fingerprints of suspect and innocent. 

 Then we are getting the output of fingerprint who had committed crime. 

  

 
 

 

5.RESULT: 

 Fingerprint images in crime scene are important clues to solve serial cases. In this paper we 

present a complete crime scene fingerprint identification system using deep machine learning 

with Convolutional Neural Network (CNN). Images are acquired from crime scene using 

methods ranging from precision photography to complex physical and chemical processing 

techniques and saved as the database. The images collected from the crime scene are usually 

incomplete and hence difficult to categorize. Suitable enhancement methods are required for pre-

processing the fingerprint images. Minutiae are extracted from the fingerprint images. The 

features of preprocessed data are fed into the CNN as input to train and test the network. 

 

6.CONCLUSION: 

 

 Fingerprint image identification is a critical component of crime detection and forensic 

investigations. The uniqueness and permanence of fingerprint patterns make them a reliable 

biometric identifier for individual recognition. The existing system of fingerprint image 

identification has significantly contributed to solving crimes and bringing offenders to justice. 

The proposed system builds upon the existing system by incorporating advancements in 

technology, methodologies, and data management. Through advanced fingerprint collection 

https://i0.wp.com/randomnerdtutorials.com/wp-content/uploads/2018/01/enroll-finger.jpg?quality=100&strip=all&ssl=1
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techniques, enhanced latent print analysis, robust feature extraction algorithms, and intelligent 

matching algorithms, the proposed system aims to improve the accuracy, efficiency, and 

reliability of fingerprint identification. 

 

 Processes, Additionally, the  

 

proposed system addresses challenges such as large-scale database management, integration with 

other biometric technologies, and enhanced data security and privacy measures. By continuously 

researching and developing new techniques and technologies, the proposed system aims to stay at 

the forefront of advancements in the field of fingerprint image identification. Overall, fingerprint 

image identification plays a crucial role in establishing the identity of individuals, corroborating 

evidence, identifying suspects, searching criminal history databases, and supporting the 

prosecution of offenders. The existing and proposed systems contribute to the field of forensic 

science, ensuring the fair administration of justice and the maintenance of law and order. As 

technology continues to advance, it is essential to continually improve fingerprint image 

identification systems, address challenges, and adapt to evolving needs. By doing so, law 

enforcement agencies can leverage the power of fingerprint analysis to enhance crime detection 

capabilities, solve complex cases, and ensure the safety and security of society. 
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